AppPerfect Software License Agreement
IMPORTANT: READ THIS AGREEMENT CAREFULLY BEFORE YOU INSTALL, COPY,
DOWNLOAD OR USE THE SOFTWARE ACCOMPANYING THIS PACKAGE
This AppPerfect Software License Agreement "ASLA" is a legal agreement between
"You" (either an individual or a single entity) and AppPerfect Corporation (referred herein as
"AppPerfect") for the AppPerfect software products and printed and/or electronic
documentation accompanying this ASLA (collectively referred herein as "SOFTWARE").
By installing, copying, downloading or using the SOFTWARE, You agree to be bound by the
terms of this ASLA. If You do not agree with all the terms of this ASLA, AppPerfect is
unwilling to license the SOFTWARE to You. In such an event, You may not install, copy,
download or use the SOFTWARE and You must return to AppPerfect the complete
SOFTWARE package, including the disks and printed materials or if you downloaded the
SOFTWARE, notify AppPerfect in writing that You have de-installed the SOFTWARE within
thirty (30) days of receipt for a refund of the purchase price.
1. LICENSE.
1.1 Grant. Subject to the terms and conditions of this ASLA, AppPerfect hereby grants to You
a limited, non-exclusive, non-transferable license to use the SOFTWARE for the authorized
use for which You have paid AppPerfect a license fee. This SOFTWARE is licensed for use,
not sold. AppPerfect and its suppliers retain all rights in the SOFTWARE.
1.2 Mechanism: The AppPerfect Java Unit Test, AppPerfect Java Code Test, AppPerfect
Java Profiler, AppPerfect Web Test, AppPerfect Load Test and AppPerfect App Test products
are licensed for installation on a single client machine and for use by a single user. The
AppPerfect Test Manager and AppPerfect Agentless Monitor Server is licensed for the
machines on which it is installed. AppPerfect Agentless Monitor is licensed for each device
(as defined by the SOFTWARE ) that is monitored.
1.3 Term. The license granted herein begins upon installation, copying, downloading or use of
the SOFTWARE and continues in perpetuity unless sooner terminated. Without prejudice to
any other rights, AppPerfect may terminate this ASLA if You fail to comply with the terms and
conditions of this ASLA.
1.4 No Copies. Except as expressly allowed by the terms of this license, You shall not copy or
modify any portion of the SOFTWARE other than that You may make one (1) copy of the
computer program portion of the SOFTWARE solely for archival purposes.
1.5 Other Limitations. You shall not rent, lease, loan, sell or otherwise distribute the
SOFTWARE or use the SOFTWARE as an application service provider, as a service bureau,

or in a fee-generating service provided to third parties. You shall not reverse engineer,
decompile or otherwise attempt to derive the source code for the SOFTWARE.
2. CONFIDENTIALITY; OWNERSHIP.
2.1 Title and Ownership. All titles, ownership rights, and copyrights and other intellectual
property rights in the SOFTWARE shall remain in AppPerfect and/or its suppliers. You
acknowledge such ownership and intellectual property rights and will not take any action to
jeopardize, limit or interfere in any manner with AppPerfect's or its suppliers' ownership of or
rights with respect to the SOFTWARE. The SOFTWARE is protected by copyright and other
intellectual property laws and by international treaties. Nothing in this license shall be
construed as a grant in or a transfer of any proprietary rights. This SOFTWARE is licensed for
user, not sold.
2.2 Proprietary Information. You agree that the SOFTWARE and all computer code,
inventions, algorithms, know-how and ideas embodied in or by the SOFTWARE and all other
business, technical and financial information You obtain from AppPerfect, whether designated
confidential or not (hereinafter referred to as "Proprietary Information") are the confidential
property of AppPerfect. You also agree that any expression of AppPerfect's findings,
analyses, conclusions, opinions, recommendations, ideas, techniques, know-how, designs,
programs, enhancements, SOFTWARE, and other technical information provided to You by
AppPerfect in the course of performing consulting, training, maintenance or other services
related to the SOFTWARE are the Proprietary Information of AppPerfect and are licensed to
You, pursuant to this ASLA.
2.3 Non-Disclosure. You agree to keep the Proprietary Information in a secure place, under
access and use restrictions designed to prevent disclosure of the Proprietary Information to
unauthorized persons and to instruct Your personnel to keep the Proprietary Information
confidential.
2.4 Breach. You agree that any disclosure of the Proprietary Information to a Third Party
other than in accordance with the terms of this ASLA constitutes a material breach of this
ASLA and will terminate the license granted by this ASLA.
2.5 Injunctive Relief. You further agree that You will be liable for all damages to AppPerfect
that result from any wrongful disclosure of the Proprietary Information to any Third Party or
any breach of this ASLA. You acknowledge that such wrongful disclosure or breach could
cause irreparable injury that cannot be compensated by monetary damages and that
injunctive or other equitable relief may be appropriate.
3. PRODUCT MAINTENANCE.
You understand and agree that AppPerfect may provide updates to the SOFTWARE from
time to time but AppPerfect shall have no obligation to provide maintenance or updates to

You for SOFTWARE licensed under this ASLA.
4. DISCLAIMER OF WARRANTY AND LIABILITY.
4.1 THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. TO
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, APPPERFECT FURTHER
DISCLAIMS ALL WARRANTIES, INCLUDING WITHOUT LIMITATION ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. THE ENTIRE RISK ARISING OUT OF THE USE OR
PERFORMANCE OF THE PRODUCT AND DOCUMENTATION REMAINS WITH YOU, THE
LICENSEE.
4.2 TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT
SHALL APPPERFECT OR ITS SUPPLIERS BE LIABLE FOR ANY CONSEQUENTIAL,
INCIDENTAL, DIRECT, INDIRECT, SPECIAL, PUNITIVE, OR OTHER DAMAGES
WHATSOEVER (INCLUDING, WITHOUT IMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE
THE PRODUCT OR DOCUMENTATION, EVEN IF APPPERFECT HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES/JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.
5. TERMINATION.
5.1 Basis for Termination. AppPerfect may terminate this ASLA if You commit a material
breach of this ASLA
5.2 Obligations Upon Termination. Upon termination of this ASLA, You will immediately
destroy or return to AppPerfect all SOFTWARE and Proprietary Information in Your
possession.
5.3 Effect of Termination. The following provisions shall survive termination of this ASLA: 2, 4,
5.2, 5.3, and 6.
6. GENERAL TERMS AND CONDITIONS.
6.1 Severability. If any provision of this ASLA is found by any court of competent jurisdiction
to be invalid, then the remaining provisions shall nevertheless remain in full force and effect.
6.2 Choice of Law and Venue. This ASLA shall be governed by and construed under the laws
of the State of California without regard to conflicts of laws or provisions thereof, and without
regard to the United Nations Convention on Contracts for the International Sale of Goods.
You agree that the federal and state courts within Santa Clara County, California shall have

exclusive jurisdiction to adjudicate any dispute arising out of this ASLA.
6.3 Complete Agreement. This ASLA is the complete and exclusive statement of the mutual
understanding of the parties and that it supersedes and cancels all previous written and oral
agreements and communications relating to the subject matter of this ASLA. AppPerfect
disclaims all preprinted terms of any purchase order or other written instrument submitted by
You.
6.4 No Modification. You agree that this ASLA can be modified only by a written agreement
duly executed by persons authorized to execute agreements on behalf of the parties hereto.
6.5 No Waiver. You agree that any failure or delay to exercise or any partial exercise of any
right, power, or privilege hereunder by AppPerfect shall not operate as a waiver.
6.6 Attorneys' Fees. If any legal action is necessary to enforce the terms of this ASLA, the
prevailing party shall be entitled to reasonable attorneys' fees and costs in addition to any
other relief to which that party may be entitled.
6.7 Export Laws. You shall comply with all then current export laws and regulations of the U.
S. Government and the government of the country in which You receive delivery of the
SOFTWARE, which pertain to the SOFTWARE. You may not install the SOFTWARE outside
of the country to which the SOFTWARE was initially shipped.
7. U.S. GOVERNMENT RESTRICTED RIGHTS.
The SOFTWARE, including related documentation, is provided with Restricted Rights. The
use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in
this ASLA, and in the applicable provisions of subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause DFARS 252.227-7013, or subparagraphs (c)
(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19.
The manufacturer is AppPerfect Corporation, 11651 Timber Spring Court, Cupertino, CA
95014.
Should you have any questions concerning this ASLA, or if You desire to contact AppPerfect
for any reason, please write:
AppPerfect Corporation, 11651 Timber Spring Court, Cupertino, CA 95014
Acknowledgement of Third Party Software
This AppPerfect software contains certain third party software as listed below which are
acknowledged here. These are open source software for which you may obtain source and
binaries from the URL listed next to the software.
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Apache Ant (http://ant.apache.org/)
Apache BCEL Library (http://jakarta.apache.org/bcel/index.html)
Apache Commons Library (http://jakarta.apache.org/commons)
Apache Jakarta ORO (http://jakarta.apache.org/oro/index.html)
Apache Log4J (http://jakarta.apache.org/log4j)
Apache POI Excel Library (http://jakarta.apache.org/poi/index.html)
Apache Struts Framework (http://jakarta.apache.org/struts)
Apache Tomcat JSP/Servlet Engine (http://jakarta.apache.org/tomcat)
Apache Xerces XML Library (http://xml.apache.org/xerces2-j/index.html)
Apache Web Service related Libraries (http://ws.apache.org/)
Bouncy Castle Crypto APIs for Java (http://www.bouncycastle.org/java.html)
Direct Web Remoting (http://getahead.org/dwr)
Eclipse.org (http://www.eclipse.org)
Hibernate (http://www.hibernate.org/)
HSQL Database Engine (http://hsqldb.sourceforge.net/)
HTML Parser (version 1.6)(http://htmlparser.sourceforge.net)
HtmlUnit (http://htmlunit.sourceforge.net/)
Impression Math Expression Java parser (http://impression.sourceforge.net/)
iText PDF Library (http://sourceforge.net/projects/itext/)
Java Service Wrapper (version 3.2.3)(http://wrapper.tanukisoftware.org/doc/english/
download.jsp)
JavaAssist (http://jboss.org/javassist/)
Java Communications API (http://java.sun.com/products/javacomm/)
jregex - regular expressions for Java (http://sourceforge.net/projects/jregex)
JUnit (http://www.junit.org/index.html)
JCraft JSch (http://www.jcraft.com/jsch/index.html)
Mibble SNMP MIB parser (version 2.2)(http://www.mibble.org/index.html)
Remote Tea ONC/RPC for Java (http://www.plt.rwth-aachen.de/ks/english/remotetea.
html)
Rhino (http://www.mozilla.org/rhino/)
Quartz Scheduler (http://www.quartzscheduler.org/)
SmsJ SMS library for the Java platform (http://sourceforge.net/projects/smsj/)
Spring Framework (http://www.springframework.org)
StrutsTestCase for JUnit (http://strutstestcase.sourceforge.net/)
Subclipse plug-in for Subversion (http://subclipse.tigris.org/)
Subversion Server (http://subversion.tigris.org/)
Web Services Description Language for Java (http://wsdl4j.sourceforge.net/)
Westhawk's SNMP stack in Java (http://snmp.westhawk.co.uk)

Introduction
Unit testing is an indispensable means of ensuring high quality software. Unit testing
generally refers to concentrated and focused testing of each smallest logical unit of your
software. This unit may be a module, a package, a file, or a class. It is highly recommended
that unit tests be conducted at the smallest unit of your software. For most Java developers, a
class represents a typical unit to be tested.
Unit tests are the building blocks of your testing infrastructure. As you develop new "units" of
your software, you should also simultaneously develop units tests for them. Once the new
units are integrated into your software, the unit tests should also be integrated into the suite of
unit tests that already may exist.
While most developers recognize the importance of unit testing, often due to lack of time, unit
tests are not designed and run in a comprehensive and consistent manner. To save time,
many developers tend to run unit tests in some form of automated manner. In fact, many
users use advanced tools to help with generation and execution of unit tests. This is where
AppPerfect Java Unit Test comes into the picture.

Need for AppPerfect Java Unit Test
AppPerfect Java Unit Test performs the following key functions for you:
●
●
●

Automatically generate unit tests for your source
Automatically update unit tests as your source changes
Automatically execute the tests when asked for

AppPerfect Java Unit Test uses JUnit and HtmlUnit as the unit testing frameworks. Using
AppPerfect Java Unit Test can help developers save significant amount of time that would
otherwise be spent on manually creating and running the tests.

AppPerfect Java Unit Test Key Features
With the AppPerfect Java Unit Test the effort you, as a programmer, have to put into
unit testing is greatly reduced. It automates Test Case generation and execution with
extensive reporting for reference and analysis purpose. In addition it also provides
comprehensive test-case management tools. AppPerfect Java Unit Test offers you a variety
of features to ease and streamline your process of Unit Testing:
●

Uses JUnit and HtmlUnit framework: AppPerfect Java Unit Test uses JUnit

framework, the most commonly used framework, to generate and test Java source. To
unit test server-side Java source (JSP/Servlets/EJB) it uses HtmlUnit framework.
●

●

●

●

●

●

●

●

Automatic Generation of test cases: AppPerfect Java Unit Test automatically
generates full test cases, by going through code and understanding it. AppPerfect
Java Unit Test goes beyond generating simple stub classes for JUnit testing. It
generates fully functional, highly intelligent test classes that understand your
application and test your source files thoroughly. It also provides easy to use UI to edit
your test cases. It automatically maintains these test cases as your code changes, so
if you delete any method in your source, AppPerfect Java Unit Test will take care of
deleting the corresponding test cases from test class files and so on.
Functional Test cases: AppPerfect Java Unit Test provides an uitlity called
Object Tracer which allows users to run their application normally and monitors the
object creation during the normal working of application. It records this information and
later creates test cases by creating exactly same objects, this way user can generate
functional test cases for their applications and can use these test cases for regression
testing.
Object Repository: AppPerfect Java Unit Test uses concept of mock objects to
unit test your source code. It generates mock objects and stores them in a repository
called Object Repository. You can manage these objects using Object Repository
Manager.
Supports Stubbing: AppPerfect Java Unit Test supports stub code generation, this
is useful when some part of application is not available or is not developed yet. For
example your application requires a database connection but same is not available
then you can stub getConnection call and return some dummy connection object in
place, Unit Test will take care to execute your stubbed code in place of actual
getConnection call while unit testing the code.
Supports Mock Database: AppPerfect Java Unit Test supports mock database
functionality. This functionality is provided: a) to allow users to test their code during
development phase without actually going to original database, b)During development
some times users enter junk data hence to prevent original database from getting
corrupt. c) To save developers time as during development if users enter junk data
and it goes to original database then users are required to spend some time cleaning
database, d) At lot of time database must be in some state for testing certain piece of
code hence to maintain that state of database for users.
Importing of existing JUnit tests: AppPerfect Java Unit Test can import a
existing JUnit test cases and and execute them along with Unit Test generated test
cases and can report the results.
Browser recording: You can use the browser recording facility to create the tests
as you would normally work with your application. There is no need to learn any
proprietary scripting language. You can then edit and run the test fast and easily. All
web browsers are supported for recording, including Internet Explorer, Netscape,
Mozilla, and Firefox.
Support for basic authentication, cookies, SSL: With the AppPerfect Java
Unit Test, you can unit test JSP applications that require basic authentication as well

as those using HTTPS by allowing the configuration of the SSL Provider. It also
handles the sending of cookies with the appropriate requests and supports URL
rewriting if your application uses it. Two way SSL authentication is also supported.
●

●

●

●

Informative and User friendly reports: AppPerfect provides comprehensive
reports that help you identify failure points of the test. These reports can be viewed in
the UI or exported to HTML, PDF CSV, XLS, XML etc.
Scheduling and Notification: You can automate your testing by scheduling them
using the Test Manager product. You can also use the Notifications manager module
of the Test Manager product to send an email, SMS or file notification when a test is
complete.
IDE Integration: AppPerfect Java Unit Test supports IDE integration with most
commonly used IDEs. This enhances ease-of-use and productivity. Currently
supported IDEs are Eclipse, NetBeans, IntelliJ, JBuilder, JDeveloper and Workshop.
ANT Integration and Command line execution: AppPerfect Java Unit Test
supports ANT integration so it can be easily integrated into most development/build
environments. Unit Test also supports command line execution so you can unit test
your source code by invoking product from a bat or sh file.

About AppPerfect Products
AppPerfect offers following products for complete and comprehensive solution for testing and
monitoring the performance of your application. These products that are designed to help you
test your application throughout the development life-cycle.

AppPerfect Java Unit Test:
AppPerfect Java Unit Test is a feature-rich wrapper for the popular JUnit and HtmlUnit testing
frameworks for non-web and web-based Java projects respectively. It provides the Java
programmer with an easy to use and fully customizable unit-testing environment, which can
be integrated with popular Java IDEs as well as the project's build process.

AppPerfect Java Code Test:
AppPerfect Java Code Test reads your software code and analyzes it for optimization, errors,
coding conventions, complexity and style based on industry-standard rules. Over 750 predefined, high-value rules can be applied to your code. AppPerfect Java Code Test is an ideal
tool to perform code reviews on an on-going basis to ensure high quality of code.

AppPerfect Java Profiler:
AppPerfect Java Profiler profiles a Java Virtual Machine to assist you in understanding the
behavior of your application as it performs its functions. AppPerfect Java Profiler recognizes

that your application does not operate in a vacuum and hence provides a unique blend of
Java information combined with operating system information.

AppPerfect App Test:
AppPerfect App Test performs regression and functional testing of your Windows/Desktop
applications. Performing manual functional testing by having a person sit and manually click
away at the application is extremely expensive and error-prone. AppPerfect App Test
provides the means to perform such labor-intensive activity in an automated manner.

AppPerfect Web Test:
AppPerfect Web Test performs regression and functional testing of your Web applications.
Performing manual functional testing by having a person sit and manually click away at the
application is extremely expensive and error-prone. AppPerfect Web Test provides the means
to perform such labor-intensive activity in an automated manner.

AppPerfect Load Test:
AppPerfect Load Test is a stress/load testing tool that can simulate hundreds of virtual users
from a single machine. Features supported include site recording, dynamic variable
substitution, cookies support, session tracking, SSL support and run strategies. It can run
tests based on a variety of strategies such as burst, incremental, exponential, quadratic or
loop. It also provides you a comprehensive solution to monitor various attributes of various
operating systems present in your application infrastructure.

AppPerfect Test Manager:
The AppPerfect Test Manager is central server with a Web-based UI for accessing various
modules in the server. AppPerfect Test Manager consists of five main modules:
Requirements Manager: This module is used to create requirement specifications
around which your tests will be designed and executed. Functional, business, performance,
technical and usability requirements should be defined here to ensure the tests cover all
defined criteria.
Test Manager: Once tests have been designed, the Test Manager can be used to manage
the execution of your tests. Automatically running tests on a specific schedule, notification of
test results, saving of test results, etc. can be defined in this module.
Results Manager: Once results for your various tests have run a few iterations, the
Results Manager can be used to manage the archived results. Trend Analysis of multiple
results to detect key quality trends is a key feature of this module. Storage management can

also be performed via this module.
Issues Manager: As tests are run, issues such as defects, enhancements, modifications,
etc. will occur. This module can be used to create and track such issues. This module is
designed as a light-weight issues manager that seamlessly integrates with the rest of the
server and is not intended to replace full-featured issues management system.
License Manager: Floating/site licenses are managed using this module. This module
acts as the central manager for issuing and reclaiming floating licenses for the AppPerfect
products.

AppPerfect Agentless Monitor:
The AppPerfect Agentless Monitor is an agentless, Web-based monitoring solution. It helps
you monitor your applications and the underlying system resources. The AppPerfect
Agentless Monitor consists of:
AppPerfect Monitor: A pure Web-based solution that helps you monitor your application
infrastructure. Provides a rules engine to define alerts: a notification server for email and SMS
notifications. Also includes a powerful report designer to create custom reports to analyze and
understand the performance data.
AppPerfect Monitors: A series of modules designed to support specific devices.
AppPerfect Monitor does not use the traditional agents-based approach to monitoring. Apart
from being expensive, agents-based approach is also highly complex and error-prone.
AppPerfect Monitors are designed to impose negligible overhead on the monitored system.
These monitors are superbly optimized programs providing the maximum amount of
information while imposing the lowest possible overhead.
Currently, the following devices are supported:
●
●
●
●

Java/J2EE App Servers (Tomcat, WebLogic, WebSphere, etc.)
Operating Systems Resources (Windows, Linux, Mac OS X)
Databases (Oracle, MySQL, MS SQL, DB2, Sybase)
Web Servers (Apache HTTP Server, MS IIS)

●

SNMP Monitors (v1 and v2)
Ping Monitor (Device heartbeat monitor)

●

Mail Server (MS Exchange)

●

About AppPerfect Corporation
AppPerfect Corporation is an independent software development company dedicated to

providing the developer community with the best-in-class tools throughout the entire software
life-cycle. Our aim is to be your primary vendor for most of your development- and
deployment-tool needs. Our mission is to help you reduce your software development costs,
increase your productivity and help improve the availability and scalability of your
applications. Please visit us on the Web at www.AppPerfect.com for more information.

Getting Started
This chapter covers information relating to the minimum system requirements, getting product support, starting the
AppPerfect Java Unit Test, selecting the type of project to be created and overview of how to access the documentation
provided with the AppPerfect Java Unit Test and also how to access Help while using the AppPerfect Java Unit Test.

Minimum System Requirements
Minimum system requirements for installing AppPerfect Java Unit Test products are listed below:
System Parameter Requirement
Operating System

Microsoft Windows 2000/XP/2003, Linux x86, Mac OSX

RAM

512 MB

CPU

1 GHz

Disk Space

130 MB

NOTE: The preferred screen area or resolution for the AppPerfect products is 1024 x 768
pixels.

Startup instructions
You can start using the AppPerfect Java Unit Test in any of the following ways:
For Windows
Shortcut:
Follow this path:
Start -> Programs -> AppPerfect Java Unit Test x.x.x -> AppPerfect Java Unit Test
Installation Folder:
Follow these steps:
1. You have to browse to the location where you have installed AppPerfect Java Unit Test
2. From the %UnitTest_Home%\eclipse folder, run UnitTest.exe
Once AppPerfect Java Unit Test starts up, click AppPerfect Java Unit Test icon.
For Other Operating Systems
Shortcut:

1. In the path provided while installing, you can see the AppPerfect_UnitTest_x.x.x shortcuts folder.
2. An executable link file: AppPerfect_UnitTest_x.x.x is provided there. Run it.
Installation Folder:
1. Go to AppPerfect Java Unit Test home folder
2. Run the file $UnitTest_Home/eclipse/UnitTest

Inside AppPerfect Java Unit Test
You can read a brief overview of AppPerfect Java Unit Test in the Welcome screen. Now you can start using AppPerfect
Java Unit Test to unit test your Java/JSP code.

Supported Products
AppPerfect Java Unit Test supports the following products:
Products Category

Products Supported

Operating Systems

Microsoft Windows 2000/XP/2003, Linux x86, Mac OSX

Browsers

Internet Explorer 5.x or higher, Mozilla Firefox, Safari, Google Chrome, Opera

AppServers

Apache Tomcat 4.x/5.x; BEA WebLogic 7.x/8.x; IBM WebSphere 5.x; JBoss 3.x/4.x;
Macromedia JRun 4x, Resin2.x/3.x, Orion 2.x, OracleAS 10g, Jetty4.x/5.x, SunOne 7.x/8.x

IDE

Eclipse 2.1.x/3.0, NetBeans 4.0/4.1/5.0, IBM WSAD 5.1.x, IBM RAD 6.0, IntelliJ
3.0.5/4.0/4.5/5.0, JBuilder 9.x/10.x/2005/2007, JDeveloper 9.x/10.x

Java versions

JDK 1.3.x, JDK 1.4.x, JDK 1.5.x, JRockit 1.4.2 and higher, IBM JDK 1.3.1 and higher

Using the Documentation
Help can be invoked from anywhere in the application by pressing F1. To view the Table of Contents after context
sensitive help has been brought up, scroll to the top of the page and click Show link. This will bring up the contents in a
frame on the left. Alternatively, the Table of Contents in the Help menu.
If you want to go through the entire documentation or search for a specific topic, then perform any of the following
actions:
Using the shortcut: Click Start point to Programs> AppPerfect Java Unit Test x.x.x> Documentation
in Windows, or go to /AppPerfect_UnitTest_x.x.x/Documentation for Linux.
You can search for a specific topic, by performing any of the following actions:
●

You can either find your topic in the contents (Table of Contents) in the left-hand-side frame or

●

You can search for relevant information using the Search or Index tabs.

The documentation is also available in PDF format online and can be accessed as follows:
Using the shortcut: Click Start -> Programs -> AppPerfect Java Unit Test x.x.x -> Documentation >
Print Manuals in Windows.
To start with, it is recommended that you read through all the topics following the sequence of the contents for a better
understanding of the product and the features it provides. Glossary provides explanations of commonly used terms in
AppPerfect Java Unit Test.

Getting Product Support
If you need additional assistance with our products, please contact AppPerfect at the email address specific to your
query:
Sales: sales@AppPerfect.com
Support: support@AppPerfect.com
Online Technical Support (FAQs, Tips, Tutorials, Docs): AppPerfect Java Unit Test
Comments and suggestions
The AppPerfect Development Group welcomes and appreciates your comments and suggestions. Please send all
comments/suggestions at our direct email address at: support@AppPerfect.com

Creating a New Project
To create a new project in AppPerfect Java Profiler, AppPerfect Java Unit Test or AppPerfect
Java Code Test, follow these steps:
1. Start the desired AppPerfect Product.
2. Once the product starts. Click File -> New...
AppPerfect uses a project wizard for AppPerfect Java Profiler, AppPerfect Java
Unit Test and AppPerfect Java Code Test products. Once a project is defined, you
need to specify certain values related to the specific product (Web Test, Load Test and App
Test) for which you are creating the project. Listed below are the various properties which can
be set using new project dialog.
●

General

●

Import

●

Source

●

Java Settings

●

Environment

●

Target

General
Project
The 'General' panel requests information regarding your project's name and its location on
your system. By Default, all the projects are stored in the 'Workspace' folder of the
AppPerfect installation directory.
NOTE: If you provide a project name that already exists, AppPerfect will over-write the
contents of the existing project's folder.
Target Application's Machine Settings
In case target application Application / AppServer is running on remote machine then you
should select this option. You should have product installed on remote machine and remote
product's service running for this to work correctly. Find below details of the service settings
for each of the product:

●

●

●

By default for AppPerfect Java Profiler product the service runs at 8834. So the
service url in this case would be http://remote_host:8834/AppService
By default for AppPerfect Java Code Test product the service runs at 8794. So the
service url in this case would be http://remote_host:8794/AppService
By default for AppPerfect Java Unit Test product the service runs at 8814. So the
service url in this case would be http://remote_host:8814/AppService

Notification Settings
AppPerfect can send you customized notifications of your test results. This feature is very
useful in cases where you want to schedule AppPerfect to run tests or perform code analysis
and do not want to wait for the results. For example, you can receive the results in your
mailbox with (optional) HTML reports attached. You can choose to be notified on test
completion or only if the test fails.
The following settings are required for the Notifications feature:
1. Send Notification on: Project completion or Project failure, as is your requirement.
2. Notification Message: Click the button to create your own customized notification
message using the variables relevant to your AppPerfect product.
3. Email / Custom Notification Settings: Provide the required email or custom
notification settings where you want application to send notification.
NOTE: If you opt for Notifications you must configure notification settings in AppPerfect
Test Manager application and you must configure Test Manager information in
tools > Options > Server Connections dialog in AppPerfect client application,
otherwise, the Notifications feature will not work.

Import
Select this option to import your projects from any of the supported IDEs or Third Party
products into the AppPerfect product.
Importing from following IDEs is supported. Various versions of these IDEs are supported:
●
●
●
●

Eclipse
IBM Websphere Studio Application Developer
Rational Application Developer
IntelliJ Idea

●
●
●
●

JBuilder X
JDeveloper
NetBeans
BEA Workshop Studio

Importing from following Third Party products is supported:
●
●
●
●

Find bugs
JProfiler
JProbe
JTest

Source
Source Files/Folders
Since AppPerfect products are based on the Eclipse architecture, to add java files, you have
to add the package that contains them. Even for a single Java file, you have to add its
containing package here. The 'Add File' option can be used for adding specific Java or JSP
files.
You must provide Source path for AppPerfect Java Unit Test and AppPerfect Java Code Test
projects. In case of AppPerfect Java Profiler you should provide source settings if you wish to
trace the profiling data back to source code.

Java Settings
By default, the JDK installed by AppPerfect products is used for your projects. If you want to
use another JDK, select the checkbox 'Use Custom Java Environment'. You can create
several JDK profiles to use according to your requirements by clicking 'Configure JDK' button.

Environment Settings
Specify the CLASSPATH and LIBRARYPATH where class files and libraries for the specified
source files are located. Correct CLASSPATH and LIBRARY must be specified else project
definition will fail. Please note that without specifying the CLASSPATH, you cannot use the
Java Unit test product and cannot profile applet/desktop java applications.
Classpath
You must set a valid classpath for the selected Java source files/folders. Your classpath can

be validated by AppPerfect by clicking the 'Validate Classpath..' button.
Library Path
Specify additional libraries (in addition to the classpath already set) which should be included
in the path while running the application.

Target Application Settings
In this tab, you have to specify the details of the target application. Start with specifying the
type of the application.
Application Type
You have to specify the type of your application. These include
●

●

Server / Web Application: Select this option in case target application is a web
application deployed on Web/Application server..
Local / Desktop Application: Select this option in case target application is a
desktop java application or an applet.

There are different settings that are required to be made for each of these types of
applications. For details on each application type and its settings, please refer to the "Target
Application Settings" chapter.

Target Application Settings
The last step in creating a new project is to define your target application. Following type of
target applications are supported:
●

Server / Web Application

●

Local / Desktop Application

Server / Web Applications
Server applications are typically applications that are deployed in a J2ee application server
such as WebLogic / WebSphere etc. AppPerfect supports communication with server
application via HTTP and HTTPS protocols. Following values need to be specified to
completely define a server application.

URL Settings
●

●

●

●

Starting URL : The first page from where you want to start interacting with your
server application. This can be either an HTTP or HTTPS URL. You can provide the
URL from where you want to actually test your project instead of providing the first
page of your web application.
Authentication Basic/Digest/NTLM): For applications that need to be
authenticated, please select the appropriate Authentication mechanism and then
provide values for Username, Password and Domain name as per the authentication
setting selected.
Basic/Digest/NTLM authentication is implemented in the Web browser itself. If you are
using this kind of security mechanism, username and password need to be specified
here so that AppPerfect can connect for the first time and record the page.
Two way SSL Authentication : For applications using two way authentication,
please select this checkbox and then provide values for password and client certificate
file.
Configure Proxy Settings: If your application requires a proxy server, then you
need to provide those instructions here.

AppServer Settings
●

●

AppServer : Select the Application / Web Server from dropdown provided here.
(BEA WebLogic 8.1; IBM WebSphere 5.1; Tomcat 5.5; etc.) In case you find that your
application server is not present in the list then select the "Other" option from the list.
Server Home: Folder location where app server is installed.

●

●

●

●

Startup file: All app servers use some kind of startup batch file. Refer to your app
server documentation for name and location of your startup file.
Config file: Most app servers require a system configuration file (often called config.
xml). Provide the path for same here
Instance Name: Often app servers support multiple instances of the app server
running on the same machine. If your app server supports this kind of configuration,
specify the instance name where your application is deployed. Refer to your app
server's documentation for more details.
Debug port: Debug port is used by AppPerfect Java Unit Test to generate functional
test cases. You need not change it unless the default port 8680 used is being already
used by some other application. If you need to generate Function Test Cases, the
server should be started passing command line arguments - -Xdebug -Xrunjdwp:
transport=dt_socket,address=8680

Launch Server automatically (when required): AppPerfect can detect if the
required app server is not running, and can start it for you automatically when needed.
AppPerfect will also shut down the server automatically.

Local / Desktop Applications
Local/desktop applications typically run on your local machine as a single user system.
Following values need to be specified to define a local/desktop application. AppPerfect will
construct the necessary command and invoke your application.
●

●
●

Work folder: This is the folder location from where your application will be launched.
Most desktop applications assume some default startup directory to locate resources.
JVM Arguments: Arguments you wish to pass to the JVM (such as -MX, etc.)
Launch Target application automatically: This option is disabled by default
and is enabled only if you provide the Main class for your application or HTML file in
case of Applet. If selected appperfect launches the target application on its own. In
case this option is deselected then you will need to manually launch the target
application.

Desktop Applications
●

●

Main class/Executable jar: Class file name that launches your application. Class
that contains the main() method. You can also specify a jar file and the JVM will
automatically extract the main class file name.
Main class arguments: Arguments you wish to pass to your application at startup.
Note that on the Mac OS X, you will need to specify startup arguments with commas.

Applets

AppPerfect can test your applets-based applications. Specifying the necessary information
below to define the applet type project in AppPerfect.
●

HTML File Name: The html file that contains the applet. This is the Web page that
the browser will request.

Project Properties
Once a new project is defined using the New Project wizard, certain additional settings
specific to Unit Test are needed to configure and run your test. This dialog box can also be
accessed from the menu: Project -> Properties...
These are the tabs:
●

General

●

Test Case Generation

●

Test Case Execution

General
This tab is visible only for Server / Web Application.
General Settings
Application Type: Select the type of your web application from: Simple /
Struts / Template.
Many Web applications follow a Model-View-Controller (MVC) architecture
and use some template-based framework. In such frameworks, the URL
being used and displayed is often not the real name of the underlying JSP
file. Since AppPerfect Java Unit Test unit tests your application via HTTP
URLs, it needs to be able to access the underlying JSP file.
Applications based on the Struts framework are one type of templatebased applications for which support is provided out-of-the-box. In the
Struts based Server Project, the JSP files can have multiple mapping,
which are defined in the Struts Config file. AppPerfect Java Unit Test will
read this file for a Struts Based Project and show the mappings available in a
drop-down box.
In a Template Based Server Project, the mapping has to be provided manually
for each JSP file that has been mapped. Unlike a Struts Based project, a
Template Based project relies on unique mappings for the JSP files which
have to be provided manually in the Mapped File Name text field of the
Generate Test Classes dialog box. Simple Server Project is the one where
there is no mapping provided for JSP files. The name with the JSP file sits on

the server, is the same that appears in the browser window to the user.
Unit Test searches for the XML Struts Config file for Struts Based Project
types and then shows you the corresponding mappings for the JSP file for
which you are generating Test Cases. Since there are multiple mappings
associated with a single JSP file, you have to select the appropriate
mapped file name from the drop-down box.
Document Root : Here you need to specify the document root for your web
application. It is the root of your web application containing "WEB-INF"
folder.
EJB Settings
If your application is an EJB application, and you wish to perform an "incontainer" unit test of your application, specify the necessary values. "In
container" testing means your classes will be executed in your app server
and perform all operations exactly as it would in a production environment.
This is different from regular unit testing, where all classes are individually
tested in a new JVM instance.

Test Case Generation
Scope-based filtering: You can choose the scope for unit testing by
selecting, deselecting Public, Protected, Package and Private check boxes. Only
methods that match the specified scope will be unit tested. It is generally
a good idea to start with one scope type and then expand unit testing to
others.
Import test classes (If found in the source path provided): Enable this
option if you already have unit test cases for your source and they are
present in the source path provided. AppPerfect Java Unit Test will take
care of automatically importing those test classes and showing them in
Test Classes tab in the UI.
Generate test cases which passes null values to methods: While it is
always a good idea to test for null values, most users find it generates too
many errors and so wish to do it later on in the project, not to begin with.
Generate test case for finding uncaught exceptions: This option should be
used if you want to generate test cases to find unique uncaught exceptions
in your code. Its possible that your method may not be expecting certain
input and hence this may generate some flase results but overall its good
idea to find uncaught exceptions in the code.

Limit number of test cases generated per method: If number of test cases
per method are not restricted then product may generate 100's of test
cases per method based on complexity and number of input parameters of
the method. Usually this option should be turned off unless you know for
sure that some methods of your classes are going to result in 100's of test
cases.
Limit number of objects per source class to: Enable this option to limit
number of unique instances created for a source class. AppPerfect Java
Unit Test looks for static methods returning object of class, constructors
of class, static fields returning object of class and adds all the found ways
to object repository.
Limit depth of object creation to: Enable this option to limit depth to which
AppPerfect Unit Test should resolve the constructors. AppPerfect resolves
the constructors recursively till the depth or till it finds default no
parameter constructor or constructor with primitive parameters. Usually
its good idea to limit this depth to some low value like 1 or 2 to reduce the
number of test cases generated by tool.
Preserve user changes while re-generating test classes: Enable this option
if you want to preserve the changes done by you in the generated test
classes. If this option is off then Unit Test will either delete all user
changes. While preserving user changes if Unit Test finds that because of
those changes the test classes are not in compilable state then it can
either comment those changes or can delete those changes based on
setting done.
Generate test cases with stubs: Some times you may want to execute
some other piece of code in place of actual class/method like if you are
trying to get a connection or trying to execute a query to get resultset but
actual database is not present in that case you can create stubs to
execute some dummy code in place of Statement.Execute Query and
return some dummy resultset. This feature is very useful for test driven
development as using this feature you can simulate the behavior of
application and then later when actual code is ready can inform user not to
use stubs.
JDBC Expert: Use this feature if your application depends on database and
same is not available during testing. When an application uses JDBC, Java
Unit Test provides different ways to configure mock objects in order to
adequately unit test the code that uses databases. You should use this
feature to not corrupt / mess your actual database during unit testing.

Test Case Execution
AppPerfect Java Unit Test generates test classes from your source files /
JSPs and executes them in an intermediary step. These are dummy test
classes. After execution of the dummy test classes, Unit Test picks the
test cases which provide maximum code coverage and these are the test
classes you can see in the Test Classes tab in your project.
Working Folder: This is the folder from where the test classes will be
executed. This is useful if you are using relative paths in your application
to load files. By default its same as the project's home folder.
Time Out if test class does not complete execution in (sec.): Provide a time
out value here.
Collect Memory Leak Information: If specified, AppPerfect will detect
memory leaks in your code. The way it works is a GC is performed before a
test class starts and another GC is performed after the case class
execution is complete. Any additional objects created during that test case
execution that were not cleaned up by the second GC are reported as
memory leaks.
Report assertion failures:You can choose to report assertion failures.
Select this check box. This is useful if you are aware of the assertion
failures your project is likely to throw and want to include them in the
results.
Report exception failures:You can choose to report exception failures.
Select this check box. This is useful if you want to know what all
exceptions are getting thrown from your application. You can filter certain
exceptions if you don't want them to be reported.
Run each test class in a separate process: You can choose to run each
test class in separate JVM. This is very resource intensive and time
consuming process so should not be turned on unless required.

Additional Settings
Additional Settings are provided in Tools -> Options... -> Java Unit Test.

System Configuration
The Tools -> Options dialog box lets you specify a number of important properties to control
Java Unit Test behavior. Properties configured here are applied to all the projects in the test.
Following is a description of the various tabs and properties found in them.
●

AppPerfect

●

Browsers, JDKs & DBs

●

Custom Certificates

●

Licenses

●

Log Settings

●

Proxy Settings

●

Server Connection

●

Java Unit Test

AppPerfect
General
Number of Recent Project Files: Specify the number of project files to show in the
most recently used menu list. The default is 5.
Number of Recent Result Files: Specify the number of result files to show in the most
Recently used menu list. The default is 5.
Highlight Row/node on mouse over:This setting is for highlighting the current row you
are browsing or the current node you are visiting in AppPerfect product.
Save Result: Define your results-save strategy here. You can configure to save result for
each project run automatically or to save just last run of the project. Default value is to not
save result automatically.
User Name: Shows the name of the user configured in AppPerfect Test Manager. Multiple
users can be configured with AppPerfect Test Manager and each client AppPerfect product
can use unique user name to submit results/ projects to Test Manager. This user name is
used as identifier and is helpful in generating user based reports in Test Manager. In case
connection to Test Manager is not configured Or if there is only single user configured in Test
Manager then this field is un-editable.

Garbage Collector Settings
To control the memory usage of application during execution you can configure Garbage
collector settings here. AppPerfect takes care of forcing the garbage collection once the
specified limit is reached. You can also configure how often AppPerfect should check for
memory consumption.

Font Settings
You can set your own font for AppPerfect Java Unit Test.

Update Schedule
Application can be configured to check for new updates/release of the AppPerfect product.
On finding one application notifies the user about the availability of same. Keeping this
feature enabled ensures that you are using latest version of the product.

Browsers, JDKs & DBs
Browser Settings
Here you can configure browser which application should use to open Help files and exported
results/reports. You should have proper browser configured for application to work correctly.

JDK Settings
Specify your JDK's name and path here. AppPerfect will use the default JDK specified at the
time of installation. You may want to use other JDKs for your applications and those can be
defined and used from here.

DB Connections
You can configure Database related properties like Database name, Connection URL, JDBC
driver, User Name, password etc. here.

Custom Certificates
In case your application uses a custom SSL certificate (i.e. certificate not provided by Verisign
or Thawte), then either you need to make that custom certificate trusted by the JVM running
AppPerfect product or you may select the option to "Accept Self-signed or untrusted custom

SSL certificates."
To make the custom certificate trusted by the JVM running AppPerfect product, you need to
add the SSL certificate here. AppPerfect uses this certificate when running your test.
Certificates provided by Verisign or Thawte are automatically trusted by the "trust file" within
the JVM. All other certificates are considered custom SSL certificates. If you are using a
Custom certificate, you will need to import that certificate into AppPerfect. In case you don't
have the certificate file, open your HTTPS link in a browser and then click on the "lock" icon.
This will pop up a dialog box with "Certificate" title & General tab selected. Go to Details tab
and select "Copy to File..." option. Proceed with the wizard. On Export file format select "Base64 encoded..." radio button. Save it to some temporary location and import this certificate file.
Please note that you will be required to restart AppPerfect product after registering custom
certificate.

Licenses
License related settings are done here. You can configure license for either single client
machine or can configure the product to pick the license from Floating license server in case
you have purchased Floating license. Floating licenses are managed using License Manager
in AppPerfect Test Manager.

Log Settings
AppPerfect maintains logs of fatal exceptions for all the products. You can change this setting
here to log all messages. This option is very useful for debugging purposes. It is
recommended that you use this feature in case you are facing any issues with the product
and send us the log files. By default log files are saved at: <AppPerfect_Home>/logs.
You can configure to change the log path and save logs at different location.

Proxy Settings
General Settings
Select this option in case you are unit testing Server application and need to record http
requests as you navigate though them in browser during recording. Application uses Proxy
Recording to record these requests.
AppPerfect Proxy Server Settings
AppPerfect starts its local proxy server and sets same in target browser. By default
Application uses localhost and port 8690 to start the local proxy server. In case default port is
in use by some other application you can change it to some other value here.

AppPerfect can automatically launch and configure proxy settings in your web browser
wherever possible. If you want to do that yourself, deselect the checkbox 'Automatically
launch and configure browser for recording.'
Target Proxy Server Settings
These settings are required if you do not have a direct connection to the Internet and you
normally use a proxy server to access your application. The browser's current proxy settings
have to be specified here. By default AppPerfect assumes a direct connection to the Internet.

Filter Settings
These settings are required in case of Proxy Recording. All the patterns which are marked as
excluded here are not recorded while recording. Application by default adds common update
services installed on machine which are not part of your application and these requests
should be dropped while recording tests. You can extend this list to add more patterns which
you would like to exclude during recording.

Server Connection
Test Manager Settings
AppPerfect Test Manager settings are done here. AppPerfect Test Manager provides
functionality of requirement, project, results and issues management. It allows to schedule
various project executions, view results, export them to various formats, add/manage test
requirements and add/manage issues in the product. AppPerfect Test Manager by default
runs on port 8744 and can be accessed as http://HOST_NAME:8744/AppTestManager.

Product's Service Settings
Product related service settings are configured here. Each Java Unit Test product also installs
a product service which listens to requests from other Java Unit Test product installations on
remote machines while performing remote execution. This service by default runs on port
8814 and can be accessed as http://HOST_NAME:8814/AppService

Repository Settings
AppPerfect Repository Settings is required to share AppPerfect projects across the team.
AppPerfect provides support for Subversion(SVN) server for sharing projects across team.
AppPerfect Repository server by default runs on port 8747 and can be accessed as svn://
HOST_NAME:8747/AppRepository in case repository is created with "AppRepository" as the

root folder. For complete details on configuration of Team or Repository Server refer to Team
Server Configuration

Java Unit Test
Port Information
Various ports are used by the AppPerfect Java Unit Test to generate, compile and execute
test cases for your project. You can change the default port numbers here.

Report Settings
For Exceptions and Assertion Failures, generally you do not need to go through the stack
trace to know the reason for the failure.Hence, by default AppPerfect Java Unit Test does not
show the stack trace. But you can view the stack trace to get more details by selecting this
option and re-running the project after that.

Improve Code Coverage
Specify the values to improve code coverage. Application maintains a repository of objects
used in all the test classes of your project. Application will show the test status wizard after
executing the test classes if the code coverage achieved is less than the Code coverage cut
off. In the Test status wizard, application will show a Top 'n' instances along with instances
that application added with default values. You can edit these instances to achieve more
Code coverage.

Test Class Generation
Show classes which are used as method parameters in the source code
before test class generation: If this option is selected then application shows a dialog
before Test Class generation. This dialog shows the classes (and count) which are used as
method parameters in the source code. Application will create valid objects for these classes
during generation but it may not be able to create correct objects if class needs some values
which cannot be identified deterministically like if class is reading some file or opening some
URL etc., then application may not be able to find the exact file to pass or exact URL to open.
In such cases or in general as well if you can specify how to create instance of any class
accurately then it will help in generating more accurate test cases. Please note that providing
details on how to instantiate these classes is optional, if you do not provide these details then
application will take care of creating valid objects for the classes using some predefined
default values.

Object Repository
AppPerfect Java Unit Test extensively uses the concept of Mock Objects for unit testing.
Mock Objects generally refer to an object instance that is designed to represent a real
instance of the object. Since the real instance most often requires data from the user or
database, which is not possible while unit testing the target source code, the instance
generated by AppPerfect is called a Mock Object. Creating object instances that are as close
to the real instance as possible is critical in designing high quality unit tests. Well designed
mock objects improve code coverage and lead to better quality of unit tests.
In AppPerfect, all mock objects needed to unit test your project are stored in the Object
Repository. The Object Repository holds all the information needed to create the object
instance. This chapter explains how to create, manage and maintain your Object Repository.

Structure of the Object Repository
The Object Repository stores all the data types associated with the projects selected in
the AppPerfect Java Unit Test.
Object Repository is project-specific, it keeps adding objects as test cases are created in
the Unit Test. It is one of the most useful features of the AppPerfect Java Unit Test as it
allows you to provide various possible values for each data type your project contains. When
you add a value for a data type, Unit Test automatically generates a Test Case with that value
passed as the parameter. This is true for any number of values that you might add. Datatypes
are categorized into three types: Java classes, Mock Classes and User Classes.

Java classes
All "core Java" classes belong to this category. A core Java class is defined as any classes
whose package starts with java.* or javax.*. AppPerfect understands most core Java classes
and can instantiate them properly. Examples are String, fonts, colors, date, points, etc.
AppPerfect can also handle all collection classes (i.e. properly instantiate them) such as
vectors, arrays, lists, etc.
A special sub-category of Java classes is Primitive datatypes: boolean, byte, char,
double, float, int, long and short. Full support is provided for primitive data types. Sample
objects are created by default for each data type. You can edit existing objects or create more
objects of this type in the Repository.

Mock classes

If any Java interface or abstract class is included in your project for unit testing, and no
corresponding implementing class is found, AppPerfect will create a mock implementation of
that interface or abstract class and place it in this category.

User classes
Any class not belonging to the above two falls into this category. Hence, you may find not
only your classes listed here, but any third party libraries that you may have used.

Actions on Repository
Generate and Edit the Repository
The Repository is generated as part of the Test Generation process. Once Test Generation
process is finished, you can see the test classes in the Test Classes tab and the Object
Repository in the 'Repository Manager'. You can make changes to the Repository to add
packages, classes and instances as per your requirements. You can also regenerate the
repository, over-writing all your changes to it, to be able to start from scratch.

Exporting and Importing the Repository
You can export the Object Repository from the repository manager. The object repository for
your project can be exported and saved as an XML file.
You can re-use the exported object repository files for any of your other projects by using the
import functionality provided in repository manager.
When an existing Object Repository file is imported, it will create all the objects in the Object
Repository that do not already exist in the repository. There may also be some conflicts - that
is, repetition of items in the existing repository and the one being imported. You will be asked
for your preference in case of conflicts at the time of importing the repository. You can choose
to replace the existing object instance with the new instance from the imported Repository, or
you can stay with the existing object instance by ignoring the one from the Repository being
imported.

Actions on Classes
You can view all the data types listed in the Object Repository in a tree structure. There are
three root nodes viz. Java Classes, User Classes and The Java Classes contains the
Primitive Datatypes and various other java packages. You cannot add or delete any
Primitive Datatypes as they are pre-defined and fixed in number.

Adding Packages
You can add only java packages to the Java Classes node by using the right click on the Java
Classes node and selecting Add Package. The Input dialog box is thereafter shown and
you can enter the name of the package in the text field and click ok. If the package is a java
package it will be added to the Java Classes otherwise it will by default be added to the
User Classes node. Clicking any of the packages from the Details panel shows the classes
that are present in the package.
Deleting Packages
When you select the Java Classes, User Classes or the Mock Classes from the Repository
Tree, the Package Name and Number of Classes in each package are shown in the Package
Details panel on the right. Select the package you want to delete by clicking Delete Package
after selecting the corresponding Number of Classes column for the Package Name.
Adding Classes
Similarly, the classes can be added to the packages that are defined by using the right click
and selecting Add Class. You can also click on Add from the details panel of the object
repository after selecting the package in which you want to add a class. The class name has
to be first entered in the Input dialog box and is then added to the selected package.
Clicking on any of the classes from the Details panel shows the instances of the class.
Deleting Classes
When you select the package from the Repository Tree, the Class Name and Number of
Instances of each class are shown in the Class Details panel on the right. Select the class
you want to delete by clicking Delete after selecting the corresponding Number of Instances
column for the Class Name.

Actions on Instances
Adding Instances
When you click a class name in the repository, you can see the details of the instances of the
class in the view on the right. The details are given in a table, which lists the Instance Name,
Value, Parameter Class, Parameter Value, Value Type and Description. Each of the
instances of the class are listed in a tree like structure with the parameter classes that belong
to it. Click Add Instance to add instances to the class. This opens the Add/Edit New
Instance dialog box.
Add/Edit New Instance

Class Name: The class name is specified in this field, which cannot be modified, as the class
is already defined.
Instance Name: Specify the name for the instance of the class that you want to add.
Constructors: This is a drop-down box with the list of constructors of the selected class.
Description: The text you enter in this field will be shown in the Description column in the
Details panel of the Class.
Parameter Class: Depending on the Constructor selected, the appropriate parameter classes
are listed in the table.
Value: The various values for each of the parameter classes are listed in a drop-down box
corresponding to the parameter class.
NOTE: When adding values for Interfaces, please make sure you create an instance of a
class that implements the interface as you cannot create objects of an interface
directly..

Editing an Instance
When you click Edit Instance the Add/Edit New Instance dialog is displayed.
Class Name: The class name is specified in this field, which cannot be modified, as the
class is already defined.
Instance Name: The name of the instance that you want to edit is displayed and cannot be
modified.
Constructors: Shows the constructor of the selected class and is not modifiable.
Description: The text entered in this field can be modified and will be shown in the
Description column in the Details panel of the Class.
Parameter Class: Depending on the Constructor selected, the appropriate parameter classes
are listed in the table.
Value: The various values for each of the parameter classes are listed and can be modified
using the drop-down box corresponding to the parameter class.

Deleting an Instance
Select the Instance you want to delete and click Delete Instance to delete the selected
instance from a particular class.

Find
You can look for nodes by their names using the Find dialog.

Generating Test Cases
In this chapter we will discuss how to generate Test Cases for following types of applications.
1. Local Applications
2. Server / Web Applications

Generating Test Cases
You can invoke the Test Case Generation Wizard through the menu bar or tool bar.
Menu bar: Project -> Generate Test Cases
Tool bar: Using tool button Generate Test Cases

Local Applications
The Test Generation Wizard takes a step by step approach to generation of test cases.
Details of each step are provided at the top of the step.
1. Generating Test Classes for Java Files: Test classes are generated for Java
source files, before actually generating the test classes Unit Test will generate
required objects by parsing the source code and will add those objects to object
repository. Then it will generate dummy test classes and will execute them after that
will collect the results of execution and based on that will generate the final test
classes.

Server / Web Applications
A Server Project contains both Java and JSP files. AppPerfect uses the HtmlUnit framework
to record and execute unit tests for server projects. Server projects differ from local projects in
many ways:
1. Server projects unit test the target application via HTTP, local projects are unit tested
directly via Java calls.
2. Server project unit tests are generated by recording your interaction with your target
application via a Web browser. Recording is performed using Proxy Recording
feature. All traffic between your Web browser and the target application is recorded,
analyzed, and appropriate test cases generated. For local projects, your Java source

code is directly parsed, analyzed and appropriate Java test classes created.
3. Special features such as "in-container" testing is supported for server projects, but not
for local projects.
The Test Generation Wizard takes a step by step approach to generation of test cases.
Details of each step are provided at the top of the step.
1. Getting mapping information for JSP files: You will be able to see the list of
JSP files in a table with 'Mapped File Name' as a field. For Struts application types,
there will be a drop down box in this field from which you select the mapping
extension. For a template based application, this field is editable and you should
provide the mapping yourself. The check boxes against each JSP name name will
indicate whether or not that page has been visited during recording. Test cases are
generated only for pages that are visited during recording. Click the 'Record Test'
button to start recording. You can pause recording and navigate to the desired pages
if required. Then click 'Resume' to start recording again. Click the 'Stop' button to stop
recording. The JSPs visited can now be seen with a check mark in the 'Page Visited'
field.
2. Generating Test Classes for Java/JSP Files: First, test classes are
generated for Java source files, if any, in your server project. Then unit tests are
created for all the JSP files that have been recorded.
The process of Test Class Generation also generates the Object Repository for your project.
Next step is to run the test.

Generating Functional Test Cases
This chapter will explain the Functional Test Cases and discuss how to generate them for
following types of applications.
1. Local Applications
2. Server / Web Applications

Ordinary Test Cases versus Functional Test Cases
Ordinary test cases perform static analysis of source code to determine parameter values to
be passed to underlying method. They also pass combination of other values as parameter.
On the other hand Functional Test Cases pass the recorded values as parameters. It is
necessary to perform recording in order to generate functional test cases.

Object depth
Since a functional test case needs to produce exactly same parameter values as they were
recorded, it captures values of every parameter object and the object on which the method
was invoked during recording. In order to capture complete state of these objects, it needs to
capture state of all the objects reachable from those objects. In some cases the total number
of objects a test case ends up capturing could be large and so will be the size of the
generated test case code.
The object depth specified in project properties determines how deep it should go to capture
the objects state.

Generating Test Cases
You can invoke the Functional Test Case Generation Dialog through the menu bar or tool bar.
Menu bar: Project -> Unit Test -> : Generate Functional Test Cases
Tool bar: Using tool button Generate Functional Test Cases

Local Applications
1. Select the methods for which Functional Test Cases needs to be generated.
2. Click Start Recording. This will launch the application using the Main class

provided in Target tab of Project Properties Dialog. Each time any of the selected
method is invoked during this run, the parameter values will be recorded.
3. Once recording is done, click Start Generation. From the selected methods,
Functional test cases will be generated for those methods which were invoked during
recording.

Server / Web Applications
1. Select the methods for which Functional Test Cases needs to be generated..
2. Perform Browser recording by clicking Start Recording. Recording requires that
the server be started passing command line arguments - -Xdebug -Xrunjdwp:
transport=dt_socket,address=8680. 8680 is the port used by default, you may
pass any port provided the same port is specified in the Project Properties at Target>AppServer Settings->Debug port. If the server is already running and was not started
with these arguments, appropriate message will be displayed. If the server is Tomcat
server, then you only need to stop and restart the server using Start Server,
otherwise you will need to restart the server passing necessary command line
arguments. Each time any of the selected method is invoked during this recording
session, the parameter values will be recorded.
3. Once recording is done, click Start Generation. From the selected methods,
Functional test cases will be generated for those methods which were invoked during
recording.

Managing Projects
AppPerfect Java Unit Test provides the complete testing platform using which you can
manage various testing scenarios. There are several advantages that AppPerfect Java Unit
Test provides:
●

●

●

Once test classes are generated using your source files, you will have test cases for
all the methods as well as object instances for all objects in your project.
You can easily edit the test cases, by just providing relevant test-case code instead of
having to write a lot of supporting code.
Unit Test provides intuitive Designers for adding / editing test cases as well as objects
which obviate the need to write any code at all hence saving you precious time.

Test Cases
Add/Edit:
You can add test cases using the Designer in Unit Test.
Java Files
Add test cases for Java files by clicking the Java test class name in the Test Classes tab.
Right click the test class name and click 'Add Test Case'. You will get the 'Add Test Case'
dialog. Type in the test case name in the space provided and associate it with one of the
methods shown in 'Source Method'. If there are parameters in the source method, you will get
the list of those parameters with object instances from the Repository. Select the appropriate
object for your test case from the list. There may be multiple instances of the same object.
You can access these by clicking the 'Select Existing Instance' button. There you can see
details of each instance with its values. You can also add a new object instance here by
clicking 'Create New Instance'.
You can compile the test case you have created by saving the project. Click the 'Save' icon in
the toolbar or use the menu options File -> Save (Ctrl + S).
Now when you run the project, the results will reflect the test case you added.
JSPs
For JSPs, add a test case by clicking the JSP test class name in the Test Classes tab. Right
click it and select 'Add Test Case'. You will be prompted to enter a test case name. Enter any

name starting with 'test'. Next you will see the 'Test Generation Wizard' with an additional
step : Add/Edit Test Class
Edit
You can edit test cases by editing the Instances and Asserts related to that test case.
NOTE: If you want to add/edit test cases manually, just right click any class name and click
'Open in Java Editor'. Enter the code for your test case(s) in the Editor. Click 'Save'
from the toolbar to save the test case(s). The test class gets compiled on saving.
When you run the project, the results will reflect the new test case.

Importing Test Classes
AppPerfect Java Unit Test allows you to import existing JUnit test classes.
Click Project -> Import Test Cases...

Object Repository
In the Object Repository you can add packages, classes and instances. Look up the Object
Repository chapter for details.

HTTP Status Codes
The following tables list the HTTP/1.1 Status codes for Client and Server Errors. For more
information on HTTP status codes, look up RFC-2616 section 10.

Client Error
Error
Code
400

Error Name

BAD REQUEST

Description

The server could not understand the
client's request (browser/proxy). You
will have to correct some syntax error
and re-try the request.

401

UNAUTHORIZED

The server requires user authentication.
If the request already included
Authorization credentials, then the 401
response indicates that authorization
has been refused for those credentials.

402

PAYMENT REQUIRED

Reserved for future use.

403

FORBIDDEN

The server understood the request, but
is refusing to fulfill it. Authorization will
not help and the request SHOULD NOT
be repeated.

404

NOT FOUND

The server has not found anything
matching the Request-URI. No
indication is given of whether the
condition is temporary or permanent.

405

METHOD NOT ALLOWED

The method specified in the RequestLine is not allowed for the resource
identified by the Request-URI.

406

NOT ACCEPTABLE

No acceptable representation was
found for the requested resource. For
example, when the Browser is set for a
language that the server does not
accept.

407

PROXY AUTH REQUIRED

This code is similar to 401
(Unauthorized), but indicates that the
client must first authenticate itself with
the proxy.

408

REQUEST TIME OUT

The client did not produce a request
within the time that the server was
prepared to wait.

409

CONFLICT

The request could not be completed
due to a conflict with the current state of
the resource. This code is only allowed
in situations where it is expected that
the user might be able to resolve the
conflict and resubmit the request.

410

GONE

The requested resource is no longer
available at the server and no
forwarding address is known.

411

LENGTH REQUIRED

The server refuses to accept the
request without a defined ContentLength.

412

PRECONDITION FAILED

The precondition given in one or more
of the request-header fields evaluated
to false when it was tested on the
server.

413

REQUEST ENTITY TOO LARGE

The server is refusing to process a
request because the request entity is
larger than the server is willing or able
to process.

414

REQUEST URI TOO LARGE

The server is refusing to service the
request because the Request-URI is
longer than the server is willing to
interpret.

415

UNSUPPORTED_MEDIA_TYPE

The server does not support the media
type transmitted in the request.

416

REQUEST RANGE NOT
SATISFIABLE

None of the range-specifier values in
the Range request-header field overlap
the current extent of the selected
resource.

417

EXPECTATION FAILED

The expectation given in the Expect
request-header field could not be met
by this server.

Server Error
Error
Code

Error Name

Description

500

INTERNAL SERVER ERROR

The server encountered an unexpected
condition which prevented it from fulfilling the
request.

501

NOT IMPLEMENTED

The server does not support the functionality
required to fulfill the request.

502

BAD GATEWAY

The server, while acting as a gateway or
proxy, received an invalid response from the
upstream server.

503

SERVICE UNAVAILABLE

The server is currently unable to handle the
request due to a temporary overloading or
maintenance of the server.

504

GATEWAY TIMEOUT

The server, while acting as a gateway or
proxy, did not receive a timely response from
the upstream server.

505

HTTP VERSION NOT
SUPPORTED

The server does not support, or refuses to
support, the HTTP protocol version that was
used in the request message.

Code Coverage
The AppPerfect Java Unit Test has a unique feature which informs you of the percentage of
methods and lines covered during the execution of unit tests. This is Code Coverage. You
can see code coverage for the entire project, packages and classes as the percentage of
methods and lines covered by the unit tests. Code Coverage is very useful from the point of
view of quality assurance as it pinpoints code that has not been covered by the unit tests yet.
It also highlights unused code as it makes the programmer and/or the QA specialist aware of
the execution of each line of the code. You can see the status of the methods and/or lines
covered by the unit tests change as you make changes to the code of these unit tests. This
allows you to perform White Box testing as you are able to test specific modules, classes,
methods or lines, so that each part of the application is covered.
To increase the code coverage you can add / modify Test Cases.

Project - Level Code Coverage
Project-level code coverage is very useful for at-a-glance information on the status of code
coverage for the project. It is required for gauging the efficiency of the unit tests.

Package - Level Code Coverage
Package-level code coverage shows the percentage of methods or lines that have been
covered for each package. Package-level code coverage drills down the code coverage
analysis further to show you a more detailed view.

Class - Level Code Coverage
Class-level code coverage shows the percentage of methods or lines that have been covered
for each class.

Analyzing Results
Following is the description of the AppPerfect Java Unit Test views

Source
Displays tree of packages and files present in the project. The classes defined inside Java
files appear as child of that Java file, methods appear as child of classes. Following
information is displayed along with each method.
●
●

●

●

Number of test classes generated by AppPerfect Java Unit Test for given method
Percentage of total executable lines that were covered while executing given method's
the unit test cases
Number of test cases failed during execution. Test cases are reported as failed either
when an exception occurs during their execution or the lines covered are less than the
cut-off value. This value may be specified in project properties dialog.
Number of test cases executed successfully.

the above counts for individual methods are summed and displayed along with classes, Java
files and packages.

Test Classes
Displays tree of test classes available in the project. These test classes are the ones
generated by AppPerfect Java Unit Test or the existing ones imported into the project. Along
with each test class the following information is displayed.
●

●

Number of test cases failed during execution. Test cases are reported as failed either
when an exception occurs during execution or the lines covered are less than the cutoff value.
Number of test cases executed successfully.

Test Class OutLine
This view displays design of the test case selected in test cases tree, in the form of a
hierarchy. The view displays only those test cases which are generated by AppPerfect Java
Unit Test.

Execution Summary

Displays overall summary of the execution results i.e. total number of test cases succeeded
against total number of test cases executed. It also displays percentage of code lines covered
during test run. The bar chart allows customization, similarly the table allows you to select/
hide the columns to display.

Execution Results
Displays test case wise execution results i.e. whether a test case succeeded or failed and the
exception it threw. Full stack trace may be seen by clicking any exception. You may select/
hide the columns that are displayed by the table.

Code Coverage
Displays percentage of code lines of individual methods that were covered during unit test
execution. The view displays Code Coverage for individual methods, classes, Java files and
the entire project. When double clicked it opens the class in eclipse editor with the covered
and uncovered lines marked in different colors.
Code Coverage is important from quality assurance point of view. For every method,
AppPerfect Java Unit Test tries to generate optimum set of unit test cases that would
collectively cover maximum code lines of the method.
One should examine the lines of code which were not covered, try to add test cases (i.e. try to
pass parameters to the methods) that would cover those lines too. It may also reveal some
coding mistakes due to which certain lines of code became unreachable. An example of such
common mistake is coding an 'if' conditions which would always evaluate to false.

Exceptions
This view displays the exceptions that were thrown during the execution and the test cases
from where they originated. It considers only those exceptions which were not included in the
method definition's throws clause but and thrown during execution. This might imply that
there are certain conditions un handled by the method. Clicking 'View stack trace' displays the
full stack trace.
Similarly it also lists the test cases that failed on it's asserts. This might represent a case
where the method returned unexpected value. For example AppPerfect Java Unit Test adds a
not-null-assert in the test cases of the methods returning a value. If the original method
returns null while executing a test case, the assert condition fails and such test case is listed
by this view.
AppPerfect Java Unit Test allows inserting several types of asserts into a test case. They may

be based on method return values or class fields i.e. you may add asserts that validates
method return value or you may add asserts that would validate class field values.

Memory Leakage
This view displays the amount of memory that was allocated as result of execution of
individual test cases. One should check if the methods are allocating memory as per the
application logic. An excessive memory allocation by a test case may pin-point a memory
leak.

Problems
This view lists the syntax errors present in any of the Java files of the project.

Console
This view displays the status/progress messages logged by AppPerfect Java Unit Test during
analysis. It displays the start and end time of the test execution. It also displays any console
output produced by the application during execution of the unit test.

ANT Script Execution Option
Exporting Project as ANT Script
AppPerfect project can be exported as an ANT script allowing it to be integrated with your
build process. You can export project as ANT script using tools > Export project as
ANT Script... menu option
The Export As ANT Script Dialog Box has the following fields:
ANT Script Location: Enter the full path where you want application to generate required
ANT scripts for the project. Application will generate two files one is standard ANT Script file
that is "build.xml" and second is $Project_Name.xml file. The build.xml file just contains call to
$Project_Name.xml file, this is helpful when you want to use ANT script with build process in
that case you can just copy contents of build.xml to your build.xml file.
Save Result: Specify whether to save result after the execution of project.
Export Result: Specify whether to export result as HTML after the execution of project.

Command Line Execution Option
AppPerfect products can also be used in the non-UI mode through use of the command
prompt. However, this functionality is useful only after creating and configuring a project to
suit your requirements in the UI mode.
After creating and saving your project, you can use the command prompt to run the Java Unit
Test / Java Code Test / Web Test / App Test / Load test in the non-UI mode. The %project
name%.bat/.sh file, is used to run the Java Unit Test / Java Code Test / Web Test / App
Test / Load Test project. You can generate this file by exporting project as command line bat/
sh file using menu option Tools -> Export Project As command line... There is not much
difference between running project in the UI or the non-UI mode, as you can pass various
parameters along with the command used.
Note: For help on how to create a AppPerfect project in the UI mode, refer to Creating a new project
chapter in the documentation.

The command to be used to invoke product in non-ui mode from command line looks :For Windows:
●

"%JAVA_HOME%\bin\javaw.exe" -classpath "%APPPERFECT_HOME%\eclipse
\startup.jar" org.eclipse.core.launcher.Main -clean -noupdate -application com.
appperfect.teststudio.nonuiRunner -data "%WORKSPACE_LOCATION%" -projectfile
"%PROJECT_FILE%" -producttype %PRODUCT_TYPE%

For Linux
●

"$JAVA_HOME/bin/java" -classpath "$APPPERFECT_HOME/eclipse/startup.jar" org.
eclipse.core.launcher.Main -clean -noupdate -application com.appperfect.teststudio.
nonuiRunner -data "$WORKSPACE_LOCATION" -projectfile "$PROJECT_FILE" producttype $PRODUCT_TYPE

Note: Here JAVA_HOME, APPPERFECT_HOME, WORKSPACE_LOCATION, PROJECT_FILE and
PRODUCT_TYPE needs to be replaced with corresponding values based on machine settings.

Here "org.eclipse.core.launcher.Main" is the main class which will internally invoke the
application passed and will hand over the control to that application. The main application
class is "com.appperfect.teststudio.nonuiRunner" which will be responsible for executing the
project passed as "-projectfile" parameter. The parameter "-data" is to specify the workspace
location which should be used for executing the application and "-producttype" is a constant
integer value used to indicate which product to run from the project file. The supported

product type values are 1 for Java Code Test, 2 for Java Unit Test, 4 for Load Test, 5 for Web
Test and 8 for App Test.
To check the various parameters that can be passed as the command line arguments to the
command open the exported command line batch file in Text Editor. It has all the supported
parameters listed.

IDE Integration
IDE Integration is a highly useful feature in the AppPerfect applications. You can integrate the
AppPerfect applications with any of these popular IDEs : Eclipse, NetBeans, IntelliJ Idea,
JBuilder and JDeveloper. Once the product is installed, then any time later you can integrate
with the IDE using Tools -> IDE Integration menu-item.

Un-Integrating
You can un-integrate the AppPerfect products from the IDE from the same menu-option. Click
Tools -> IDE Integration and from the list of IDEs shown on this dialog, select the IDE from
which you wish to un-integrate AppPerfect. You must close the IDE before un-integrating.

Integrating
●

●

●

●

●

●

●

Eclipse 2.x, 3.x
❍

Plugin Installation

❍

Integration with Eclipse

NetBeans 4.0, 4.1 and 5.0
❍

Plugin Installation

❍

Integration with NetBeans

IntelliJ Idea 3.0, 4.x, 5.0 & 5.1
❍

Plugin Installation

❍

Integration with IntelliJ Idea

JBuilder 9 Personal, JBuilder X Foundation, JBuilder X Enterprise Edition
❍

Plugin Installation

❍

Integration with JBuilder

JDeveloper 10g
❍

Plugin Installation

❍

Integration with JDeveloper

IBM WebSphere Studio 5.1.x
❍

Plugin Installation

❍

Integration with WebSphere

IBM Rational Application Developer 6.0
❍

Plugin Installation

❍

Integration with WebSphere

Eclipse 2.x, 3.x
Plugin Installation
When you select the option to integrate AppPerfect with Eclipse the following steps are taken:
1. A link file "com.appperfect.<PRODUCT_NAME>.link" is created in <ECLIPSE_HOME>
\links folder.
Integration with Eclipse
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within Eclipse:
1. AppPerfect menu-item will be added within the Eclipse toolbar. Click it to launch any of
the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect products will be available as part of the IDE once started.

NetBeans 4.0, 4.1 and 5.0
Plugin Installation
When you select the option to integrate AppPerfect with NetBeans the following steps are
taken:
1. The plugins jars are placed in NETBEANS_HOME\ide<version_number>\modules folder.
2. The other required jars are placed in the NETBEANS_HOME\ide<version_number>
\modules\ext folder.
3. The config file "com-appperfect-<PRODUCT_NAME>.xml" is placed in the
NETBEANS_HOME\ide<version_number>\config\Modules folder.
Integration with NetBeans
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in

the following ways within NetBeans:
1. AppPerfect menu-item will be added within the NetBeans toolbar. Click it to launch any
of the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect product will start a new instance after gathering available details from the IDE.

IntelliJ Idea 3.0, 4.x, 5.0 and 5.1
Plugin Installation
When you select the option to integrate AppPerfect with IntelliJ Idea, the following steps are
taken:
1. A folder named 'AppPerfect' is created in IDEA_HOME\plugins.
2. The plugins jar and other required jars are placed in the IDEA_HOME\plugins\appperfect
folder.
Integration with IntelliJ Idea
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within IntelliJ Idea:
1. AppPerfect menu-item will be added within the IntelliJ toolbar. Click it to launch any of
the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect product will start a new instance after gathering available details from the IDE.

JBuilder 9 Personal, JBuilder X Foundation, JBuilder X Enterprise
Edition
Plugin Installation
When you select the option to integrate AppPerfect with JBuilder, the following steps are
taken:

Step 1: The plugins jar and other required jars are placed in the JBUILDER_HOME\lib\ext
folder.
Integration with JBuilder
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within JBuilder:
1. AppPerfect menu-item will be added within the JBuilder toolbar. Click it to launch any of
the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect product will start a new instance after gathering available details from the IDE.

JDeveloper 10g
Plugin Installation
When you select the option to integrate AppPerfect with JDeveloper, the following steps are
taken:
Step 1: The plugins jar and other required jars are placed in the JDEVELOPER_HOME\lib\ext
folder.
Integration with JDeveloper
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within JDeveloper:
1. AppPerfect menu-item will be added within the JDeveloper toolbar. Click it to launch any
of the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect product will start a new instance after gathering available details from the IDE.

IBM WebSphere Studio 5.1.x
Plugin Installation

1. A link file "com.appperfect.<PRODUCT_NAME>.link" is created in <ECLIPSE_HOME>
\links folder.
Integration with WebSphere
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within WebSphere:
1. AppPerfect menu-item will be added within the WebSphere toolbar. Click it to launch
any of the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect products will be available as part of the IDE once started.

IBM Rational Application Developer 6.0
Plugin Installation
1. A link file "com.appperfect.<PRODUCT_NAME>.link" is created in <ECLIPSE_HOME>
\links folder.
Integration with WebSphere
Once the IDE integration has taken place, you will be able to access the AppPerfect menu in
the following ways within WebSphere:
1. AppPerfect menu-item will be added within the WebSphere toolbar. Click it to launch
any of the AppPerfect products.
2. AppPerfect products can also be accessed through context-sensitive pop-up menus.
AppPerfect products will be available as part of the IDE once started.

UI Reference
This chapter gives an overview of the various User Interface components in AppPerfect Java Unit Test. When a project is
open, two frames can be seen in the project area. The left frame is the Navigation frame while the right frame holds the
panel for the selection made in the Navigationl frame.
These are the tabs in the navigationl frame:
Source
The Source tab shows the source tree for the files and folders provided for unit testing. Depending on the type of project
you have selected, you can see the following nodes here:
●

Server Pages: Lists all the JSP files. Double clicking a file name opens its source code which can be edited using
the Eclipse editor. You can see this node only for Server (with or without EJB) projects.

●

Source Files: Lists all the Java files. Double clicking a file name opens its source code which can be edited using
the Eclipse editor.

●

Action Classes: If you are working on a Server project and have selected Struts based as the type of your web
application and have have selected ' Struts Action Classes' in the Generation tab of Unit Test project settings, then
this node will list the Struts Action classes.

Test Classes
This tab lists the test classes generated by Unit Test as well as those added / imported by you

Menu Items
File Menu
Menu Option

Description

New...

Shows the new project wizard

Open...

Opens an existing project

Close

Closes the current project

Save

Saves a project to the location where it was opened from or previously saved

Save As...

Allows you to save a project to a new location and/or rename the project

Result Open...

Opens a existing result

Result Close

Closes the existing result being viewed

Result Save

Saves the result of the project

Result Save As...

Allows to save the current results of the test to a new location and/or rename the result

Send Result To...

Makes a zip file of the results of the current project and attaches it to a new email using the
default email client

Print

Prints the selected report

Recent Project Files Displays a list of recently created files
Recent Result Files Displays a list of recently accessed Result files.
Exit

Closes and exits the AppPerfect Java Unit Test

Project Menu
Menu Option

Description

Run Test

Starts analyzing the entire project

Run Selected

Analyzes only selected files

Stop Test

Stops the test

Pause Test

Temporarily stops the test. The test can be resumed from that point later on

Build Project

Builds the project: Entire project is compiled - including source classes, test classes

Build Automatically

Automatcally builds the project after any changes are made to the source/ test classes

Generate Testcases

Generates Test Cases of the selected source files

Import Test Classes...

Opens the file dialog to select test classes to import

Compile Testcases...

Compiles the testcases

Improve Code Coverage... Opens the 'Improve Code Coverage Wizard...'
Properties

Opens the project properties wizard that allows to set/change the project properties

Preferences

Opens the common project wizard which allows you to change things like source files,
project type etc.

Tools Menu
Menu Option

Description

Export As...ANT Script

Export your Unit Test project as ANT script.

Export As...Command
line

Export your Unit Test project as command line script file.

IDE Integration...

Opens the dialog box requesting selection of IDE to integrate with

Options...

Opens the options wizard that is used to set system properties

Help Menu
Menu Option

Description

Quick Help

Shows context sensitive help

Table of Contents

Shows the entire help for the system

Search

Shows the entire help for the system with the search tab selected

Technical Support

Takes you to the AppPerfect Support page on the Internet

Software Updates

Automatically updates the application.

About AppPerfect Java Unit Test Shows the information such as version, copyright related to AppPerfect Java Unit
Test

Toolbar Items
Toolbar Option

Description
Brings up the new test wizard for the creation of a project
Opens existing project
Saves current project
Starts the test. All the test settings will be checked and if there are no errors then the test will start
running.
Pauses the test temporarily and then can be restarted after some time
Stops the test. This will stop a test and the required reports will be generated.

Opens the project properties wizard
Opens the common Test Studio project wizard
Exports the results in HTML format
Options

Help

Status Bar
The Status bar is seen or hidden based on the option selected in View menu. The status bar displays (from left to right):
●

View - Shows the edition of the AppPerfect Product: Evaluation, Standard or Professional.

●

Progress - Shows the progress bar when unit testing is in progress.

●

Status - Shows the status of the project: Running Unit Test, Unit Test Paused or Unit Test Completed.

●

Time - Shows time elapsed since the unit testing started.

●

Date - Shows the current date and time.

AppPerfect Java Unit Test (AP UT) FAQ
1. What can I unit test with AP UT?
2. How does AP UT help with unit testing?
3. What is the UT Object Repository?
4. There are a number of steps in the test case generation process? What are they and
why are they needed?
5. I am having problems setting my classpath correctly. What could be the problem?
6. I already use JUnit. Can I still use AP UT?
7. I have some UI classes in my application. How do I handle them?
8. How can I use AP UT to detect memory leaks during unit testing?
9. I have a large application. How do I break down the testing?
10. Where should I place the AP UT project and the test cases?
11. My application is dependent on a database. How do I unit test if the database is not
available?
12. How are asserts handled?
13. How do I generate reports and track trends?
14. I am having problems integrating with NetBeans 4.1. What do I do?
15. My target method returns an exception as expected. How do I tell AP UT to consider
this test case result a "success" and not "failed"?
16. How do I know what code was tested and what was not tested?
17. I want to run AP UT as part of my nightly build process. What do I need to do?
18. I want to improve the Code Coverage achieved by AP UT. What should I do?
19. Which JDK version syntax are supported?
20. I have a lot of test cases and it takes a long time to execute the tests. How can I
reduce the execution time?
21. My application implements a "factory" framework. Can I use AP UT to unit test such an
application?
22. How does AP UT support Apache Struts framework?
23. How can I auto generate test cases using the parameters passed by the user while
recording my web application?
24. How can I use user inputs in local projects?
25. Will generated test cases take care of boundary conditions?
26. What are the various modes by which we can provide the user defined inputs for

testing?
27. I'm getting an error again and again. I've tried everything, but I'm stuck. What should I
do?
What can I unit test with AP UT?
Desktop and server applications. Desktop apps are tested using JUnit, server apps are tested
using HtmlUnit. For server testing, browser interaction with server app is recorded, and
appropriate unit tests created.
How does AP UT help with unit testing?
AP UT helps your unit testing efforts in many ways:
1. Automates unit test generation
2. Automates unit test execution
3. Automates unit test maintenance
What is the UT Object Repository?
AP UT implements a form of mock object framework for unit testing. When unit tests are
initially generated, AP UT examines your source code and creates necessary test classes to
instantiate and execute your source code. To correctly instantiate objects, AP UT extracts as
much information about your source code as possible and stores that information in the UT
Object Repository.
There are a number of steps in the test case generation process? What are they and why are they
needed?
The first step is to generate the object repository. AppPerfect will add all objects (user classes
as well as core Java classes) to the repository. It will try to create as valid an instance for
each object as possible based on values in the repository. The second step is to compile the
test classes that are created.
I am having problems setting my classpath correctly. What could be the problem?
A few tips on setting the classpath correctly:
1. Make sure all jar files are correctly included in your project
2. Make sure you click on the "Verify Classpath" button to ensure proper setting
3. Make sure there are no conflicting classes (perhaps from multiple versions of same
product)
I already use JUnit. Can I still use AP UT?

Yes, you can easily import and manage all existing JUnit test classes into an AP UT project.
I have some UI classes in my application. How do I handle them?
UI shows up, waits for response and times out.
How can I use AP UT to detect memory leaks during unit testing?
When defining the unit test project, specify "Check for memory leaks"
I have a large application. How do I break down the testing?
AppPerfect provides a number of ways to incrementally unit test your application.
1. Based on scope
2. Based on object type
3. Based on packages
Where should I place the AP UT project and the test cases?
You can specify any location on your file system to store the project. You can specify any
location to place your test cases. By default, the test classes are stored in the same folder as
your source code. If a different location is specified, AppPerfect will create the same directory
structure as your source code and place the test classes under the specified location.
My application is dependent on a database. How do I unit test if the database is not available?
AppPerfect provides functionality to create a mock database which acts as a substitute
database when the real database is not available. AppPerfect uses HSql, an embeddable that
supports most features of commercial databases. AppPerfect requires access to the real
database only once to be able to extract the metadata and sample values to create the mock
database.
How are asserts handled?
AppPerfect supports standard JUnit asserts that can be added to your test cases. Further,
any custom asserts can be added via the UI. Lastly, AppPerfect also supports the assert key
word in JDK 1.5.
How do I generate reports and track trends?
AppPerfect provides a full-featured reporting module called AppPerfect Analytics. Numerous

standard reports are already provided with it. You can either generate default reports or build
custom reports using AppPerfect Analytics. AppPerfect also supports the ability to save a
result of a test run. These results can then be stored in a common location. A separate
module called AppPerfect Trend Analyzer can then be used to show trends over multiple test
results.
I am having problems integrating with NetBeans 4.1. What do I do?
NetBeans 4.1 is fully supported as of release 6 of AppPerfect. If using an older version of
AppPerfect, please upgrade to version 6 or later.
My target method returns an exception as expected. How do I tell AP UT to consider this test case
result a "success" and not "failed"?
AP UT supports specifying custom asserts to a unit test case. If you are expecting an
exception in a given test case, add an "ExceptionAssert" to your test case in the AP UT Test
Editor.
How do I know what code was tested and what was not tested?
AppPerfect provides a Code Coverage module that keeps track of source code lines that
were executed. From the File view, click on the specific file or rule for which you want to view
the code coverage. Lines that were not executed are highlighted with a yellow background.
I want to run AP UT as part of my nightly build process. What do I need to do?
Any AppPerfect project can be exported as an ANT script. This ANT script can be integrated
into your nightly build process or run standalone.
I want to improve the Code Coverage achieved by AP UT. What should I do?
Often times due to some key values missing, the code coverage provided out of the box is not
high. An example would be your application depends on data coming from a text file or a
database. By providing the correct data file or database connection parameters, code
coverage can be significantly improved.
Which JDK version syntax are supported?
All JDK version higher than 1.3.1 are supported. New keywords in JDK 1.5 are also
supported.
I have a lot of test cases and it takes a long time to execute the tests. How can I reduce the execution
time?

Reducing the timeout interval often reduces execution time significantly. Not performing
memory leak testing also reduces execution time. Not performing null value tests also helps
reduce execution time.
My application implements a "factory" framework. Can I use AP UT to unit test such application?
A "factory framework" typically refers to a software architecture whereby a central class is
defined where all objects needed in your application are initialized and returned. This helps
ensure all objects in the system are properly initialized. An example of a commonly used
factory framework is the EMF in Eclipse. AP UT supports unit testing of applications that use
such factory frameworks. AP UT automatically scans for public static "objname" methods in
all specified source and use those constructors for internal use.
How does AP UT support Apache Struts framework?
AppPerfect can read a Struts mapping file automatically by which it can map your actions to
underlying jsp files.
How can I auto generate test cases using the parameters passed by the user while recording my web
application?
For a 'server' project you are allowed to navigate through the pages and enter values in
different forms. This is how Unit Test records the values entered by the user during recording
and writes this information in the generated test class.
How can I use user inputs in local projects?
Firstly, unittesting will actually unit test the methods with different types of inputs & not just the
one a user would actually like to record. But we understand that there could be certain inputs
required to initialise the application like Database drivers settings, Ports etc which are
normally passed as JVM arguments (These can be specified in the Target step in Common
project properties dialog with project type as "Local"), Other initialisations are done by reading
properties file which can be read by the application with a relative path from where it is
expected to start (For this you can specify the working directory in the Unit Test properties
dialog in the tab "Test Classes").
Will generated test cases take care of boundary conditions?
Yes, testcases are generated to check boundary conditions as well.
What are the various modes by which we can provide the user defined inputs for testing?

The various modes for providing user defined inputs are:
1. User can addd/modify the testcases directly by right clicking on the Testclass View
panel and editing the source in the default Java Editor.
2. By adding/ modifying repository instances in the Repoasitory tab. After which the
testclasses are regenerated.
3. By passing a different object instance as parameter for a testcase from the Design
View.
4. By adding/ modifying asserts from the Design View.
I'm getting an error again and again. I've tried everything, but I'm stuck. What should I do?
●

●

●

Close the currently opened project if it is open. Stop and close the application if it is
running.
Go to Tools ->Options-> Log Settings. Make sure the settings selected for all the
products is: Debug (not Fatal).
Open the project. Perform the operations that are giving you the error. The moment
you get the error, stop all operations and send us the following files:
1. All files present in <LoadTest_Home>\logs folder.
2. Project file i.e. *.adt file of that project.
3. Build number of the application. (Help->About AppPerfect...)

